LPC546XX MCUS: A 180 MHZ
ARM® CORTEX®-M4-BASED MCU
FOR YOUR COST-EFFECTIVE HMI
APPLICATIONS

BRENDON SLADE

DIRECTOR, LPC EMBEDDED ECOSYSTEM

AMF-DES-T2637 | JUNE 2017

Ny SECURE CONNECTIONS
4\ FOR A SMARTER WORLD

NXP and the NXP logo are trademarks of NXP B.V. All other product or service names are the property
of their respective owners. © 2017 NXP B.V

res
PUBLIC




AGENDA

- Session Objectives
- LPC portfolio and the LPC546xx overview

-LPC ecosystem and the MCUXpresso IDE

- Loading, Building and Running Your First SDK
Example

- emWIN
-emWIN overview and basic features
- Hands on session with emWIN
- Overview of other emWIN features
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Session Objectives

- Understand the range of LPC MCUs that can be used for graphical applications
- Learn how to use MCUXpresso IDE to develop and debug applications
- Understand how to construct and customize a touch screen GUI using emWin

PUBLIC | 2

-

| 2 |



LPC Microcontroller Portfolio

Performance

Mainstream

(o} — ()
R
o

Entry Level

v

Cortex-M0O/MO+ Cortex-M3 Cortex-M4F
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LPC546xx Series Block Diagram

ARM?® Cortex®-M4
Up to 180 MHz
Includes MPU

Core

DMA USB Audio
Up to 30-ch. PLL PLL

Power Control
Single V,, Power Supply, POR, BOD,
Reduced Power Modes

Clock Generation Unity
FRO 12/48/96 MHz, System PLL

System

32-bit Timers (5) SCTimer/PWM
Multi-Rate Timer WWDT

RTC Alarm Timer
Timers

ADC 12-ch., 12-bit, 5 Msps

Temp Sensor

Analog

Multi-Layer Bus Matrix

FLASH Up to 512 KB
RAM Up to 200 KB
EEPROM 16 KB
ROM
Memory

Ext. Mem. Ctrl SPIFI

I’C FM+ USARTSI/LIN 2.2
(10) (10)

I’S (2) SPI (10)

FLEXCOMM (Choose any 10)

o
c

A
(¢
>
=
-
=)

-------------------

HS USB (1) '
FS USB (1) :

DMIC Subsys SDIO (SD/MMC)

RIIAECATC) Up tc?::;? pins

Interfaces

CPU

* 180MHz Cortex-M4 with floating point unit
Memory

*+ Upto 512 KB Flash, Up to 200 KB RAM

+ 16 KB EEPROM

Interfaces for connectivity & sensors
* Dual CAN2.0 or CAN FD Controller Options

+ XTAL-less FS USB (H/D)

« 10 SPI, 10 12C, 10 UART, 2 I2S channels.

*+ Max 10 channels

* Graphic LCD with resolutions up to 1024x768
» 10/100 Ethernet Controller with PTP

+ Stereo DMIC subsystem
(PDM, decimator, HW VAD)

« 1xHS USB (H/D) w/ on-chip HS PHY
+ XIP from QSPI via SPIFI
» External Memory Ctrl (up to 32 bits)

* Operating voltage: 1.71 to 3.6V
 Temperature range: -40 to 105 °C
« LQFP208, LQFP100

« TFBGA180, TFBGA100
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Graphics LCD Controller

. Key features N

LPC54000

- Support for STN and TFT panels
- Up to 1024x768 resolution
- 24-bit LCD interface supports 24bpp (16M colors)
- Palette table allows display of up to 256 of 64K colors
- Adjustable LCD bus size supports various panel bus configurations
- Dedicated LCD DMA controller
- Hardware cursor support
- Graphic Library Support
- Segger’'s emWin graphic library free to use with NXP’s microcontrollers

- Other supported graphic libraries include Draupner’'s TouchGFX, TARA Embedded Wizard,
Expresslogic GUIX and MicroEJ

- MCUXpresso SDK support
- Significantly reduces your software porting effort
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LPC546xx Target Applications

Industrial, Control & Smart Home & Automotive Smart
General Embedded General Consumer Aftermarket Energy
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LPCXpresso54608 Development Board

- LPCXpresso V3 feature set

- Built-in CMSIS-DAP/J-link debug probe,
option for using off-board probe

- LPC54608 MCU running at 180MHz

- 43" TFT LCD (272x480) cap touch display

- 128Mb Micron SDRAM

- 128Mb Micron quad SPI flash

- Ethernet, DMIC, SD card ports

- Stereo audio codec

- Arduino UNO R3 compatible expansion ports
- USB full and high speed ports, with Host or Device options
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LPC ECOSYSTEM and
MCUXPRESSO IDE




MCUXpresso Software & Tools

MCUXpresso
Software and Tools

 IDE
« SDK
« Config Tools

For NXP’s ARM® Cortex®-M
controllers
e Kinetis MCUs
e« LPC Microcontrollers
* 1.MX Application
Processors IDE SDK CFG

MCUXpresso IDE

Edit, compile, debug and optimize in an intuitive
and powerful IDE

MCUXpresso SDK

Runtime software including peripheral drivers,
middleware, RTOS, demos and more

MCUXpresso Config Tools

Online and desktop tool suite for system

configuration and optimization
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MCUXpresso Config Tools

Integrated configuration and
development tools for LPC
and Kinetis MCUs

Clocks \ / Peripherals

b Y &
A

CFG

SDK ‘

Builder B
Project Project
Generator Cloner

Power
Estimator

Learn more at; www.nxp.com/mcuxpresso/config @

IS a suite of evaluation and
configuration tools that helps guide users from first evaluation
to production software development.

packages custom SDKs based on user
selections of MCU, evaluation board, and optional
software components.

: , and tools generate
initialization C code for custom board support. Features
validation of inputs and cross-tool conflict resolution.

creates new SDK projects with
generated Pins and Clocks source files.

creates a standalone SDK project
based on a example application available within SDK

release.

tool provides energy and battery-life

estimates based on a user’s application model.
Available as a standalone tool for select devices.
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http://www.nxp.com/mcuxpresso/config

LPCOpen

Software drivers and libraries for pre-2017 LPC Cortex-M devices

MCU peripheral device drivers

Common APIs across device families

Maintained and supported

Includes USB host/device, Ethernet, FatFS, SWIM graphics and emWIN
examples

Keil, IAR, MCUXpresso IDE/LPCXpresso projects

http://www.nxp.com/lpcopen

LPCOpen and Code Bundles are included in
and supported by MCUXpresso IDE
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GETTING STARTED




Hands-on — Session #1

- Hands-on session with following

objectives:

- Get familiar with importing SDK into
MCUXpresso IDE

- Building and running a basic example
(blinky) on the LPC54608 LPCXpresso

board
- Get familiar with debugging operations
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Hands-on — Session #1

- Copy MCUXpresso IDE installer executable to your PC*
- Run MCUXpresso IDE installer*

*Tools may already be installed on training laptops
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Follow along: Start MCUXpresso IDE — New Workspace

- Start MCUXpresso IDE on your system
- At the dialog box, enter a location for your workspace then click OK
- Suggest C:\MCUX _om13092\workspacel

- Note: A workspace is just a folder containing the projects that you want to actively
work on during this IDE session; new folders for workspace locations can be added
using the Browse.. button

r. Eclipse Launcher I&1

Select a directory as workspace

MCUXpresso IDE uses the workspace directory to store its preferences and development artifacts,

[] Use this as the default and do not ask again
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Follow along: New Workspace after Creation

- MCUXpresso IDE will
startup in your new empty
workspace with no initial
projects

- Note that Welcome Page
shows that IDE has been
activated (in this
screenshot with a Pro
Edition License)

r T - T — d
- workspacel - Develop - Welcome page - MCU‘Xpresso IDE1t Aagd

File Edit Navigate Search Project Run FreeRTOS Window Help

Hwi L itk O-Qr|eiv|n

v ¥ v

[¢5 Projec... 52 m| @ Welcome 3

=
B[S | &

b Y 4

A 4
A IDE

file:///C:/nxp/MCUXpressclDE_10.0.0_294 _rcl/ide/pages/registeredProEdition.htm -

MCUXpresso IDE (Pro Edition) is fully activated

Welcome to MCUXpresso IDE (Pro Edition). The software is now fully activated and has no code size limits
Note: The contents of this page are work in progress and it may contain links to pages that do not exist
Product Documentation

The MCUXpresso IDE User Guide provides instructions for using MCUXpresso. This is also available from the Help menu

® Import project(s)

) Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view.

Location

Name Version

H0) Done

O Qui. 23 9= Gle Sl = # Help->MCUXpresso User Guide
Further product documentation is provided within the MCUXpresso IDE via the Help menu
. MCUXpresso IDE (Pro Edition) “ wiHeln2Hel Conteaia
\_IDE / —_—
v Start here 7
. New project... ~ [P Installed S... 2 Propertie =l Conso Problem Me € Instructic S SWO Trac B Power Me
B8 Import SDK example(s)... @ & &

S []
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Follow along: Develop Perspective

- A “perspective” is a collection of
different “views”

- The Develop Perspective was
created to provide a single
combined Project Management
and Debugging view

- In addition to the default Develop
perspective, the MCUXpresso IDE
also supports traditional Eclipse
C/C++ and Debug perspectives

0 MCUX om13092 - Deveiop - Welcome page - MCUXpresso IDE =i
| file Edt Mavigate Semh Project Bun FreeRTOS Window Help
e o B0 QO iw| > - S22 » RSP B
k 12}
l 15 Projec... & " y =i o Welceene 1
2 (&) - 8 O fde/i/Cinap/MCUXpressolDE_10.0.0_306_beta/ide/pages/segisteredProEdtion htm - »
|
|
| x .
MCUXpresso IDE (Pro Edltlon) is fully activated
now WPy sttnated
Product Documentation
w MCUXpresso 1DE User Gatide p Lable & o

O Q. 5 ™ 2 EOu. = D

Name

* Help> MLUXu- Usor Guade

Frames prodagt doCusmentaton 15 proviied

() Installed .. I3

] Properties D Console |* Probi 0 m

Bol ¥
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SDK installation process

- All LPC products released after 2016 (except LPC8xx devices) and all Kinetis
products require an SDK to be installed before development can start

- SDK packages are built using the MCUXpresso Configuration Tool
- For this tutorial session, an SDK for LPCXpresso54608 has been pre-built

- The SDK includes not only a large set of drivers and examples, but also a complete
set of information about the device(s) and board(s) that it supports

- but User does not normally need to examine the SDK in detalil

- Can be useful to check available drivers and example code without needing to go
through the Import project steps

- SDK installation is a simple drag and drop operation

-
| 2 |
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Follow along: SDK installation process

- Copy LPCXpresso54608 SDK zip file to your PC

- Install the SDK by dragging and dropping the zip file from a file explorer over the
Installed SDK window.

- After installation of SDK is complete, click on the package in “Installed SDK”"
window. This shows various sections (folders) in SDK package.

- Expand each section to view the various components of that section.
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Follow along: Browsing an SDK installation

file Edit Navigste Search Project ‘Run  FreeRTOS Window Help
B WY O - R~ -0 Q- ®ix|» BN LD LSZIPERARS POV~ H b

- =" - - Quick Access

I(J) Installed SOKs =2 [T Properties (2 Console (% Problems [ Memory € Instruction Trace . SWO Trace Config 8D Power Measurement Tool =

[ XIB >EN-I —

') Installed SDKs fie D5 Meows Sepn Beet Bun FeeTO8 Wedew by = -
"t e 3 NS 0°Q-® N> . SHIOUEADRLFFAS -
¥ To install an SOK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs’ view. quckrecm | 1 |[F]
2 Neme Version Location o Diincates oo 0 [T] Prepenis ) Conele (4 Potbere (] Maman € betnaen Trce L, SWO Trace Contg 80 Powet Mescremant Tecl dLulBics -~
o [V ESOK 2.x LPCXpressosi| 220 [, <Default Location>/SDK 2x LPC] o [l Boards 0 gt 2
N o Devices (:lv Yz iratal an S0%, wemply drag wnd doog an 30K (nig taficider) inte tre Tntabied 4002 v
U = T L Versen Locnon
(=N ’ ;; g“‘:‘;\'”‘ £ VN L AP T AN0E 220 (-3 ‘wn«au-m-u._w’-lu-a =
oolchains . o APCHmNIE
3 Toochansetngs | 5 i T .
% > @b Components \ "’ ‘ym:«nmwm. PTIABI SPUR GENERIC 4l
& ) I B owaimiiite
Click on package open & | e came
. L T aeerapies
SDK package exploration tools £ At
B b _marpies
— & 13 Memary Settiags
Fla soes L63L R soew E364L
« D Devins
. - « B ouEs 100
| Expand each section to view g',W,!,
[ attributes of the SDK package fervharrany
B8 CUsbw Semmge
loaded B € Lk et
wn Campien
B Tookbem
9 Tooickan Semtinge
'E M-
,& deck 28
&) comrecn as
& e 13
| & ome 208
o s 208
L & oo 28
- ey ane
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Follow along: Importing an SDK example

) Quickstart Panel I

~ Start here
. New project..
. Import SDK example(s)...

& Import project(s) from file system
“

P,

<

o

T3

@ Quick Settings>>

si9 Butld all progects []

I 09+ Global Vaniables (0= Vanabl
- MCUXpresso IDE (Pro Edition)
_moe )

1) Click Import SDK
example(s) in
Quickstart panel

SDK Import Dialog |
Window

1) brporting peayectis] tor device LPCSIAIEISLY wiing bosed: LPCHpretsa’N608

Ope ns - Board and/or Device selection page
- SDK MCOy Avatlabie boans
MO Trom wetalled SO%s
NP LPCSASEEL2 Upseres bearss for i
» LBC

POSaAnL

Selocted Devier: LPCSSE0R1512 wing board: | POlpeeno 54608
Target Cores Comter-md

Description: The LICS880x are ARM Cortex-AN hased microcontralien for embedded
mpbcenng

Ploase setect a0 avlabie boand for yaur prsject.

soicw LACSMORN2

%™

— 2) Click on LPCXpresso054608
Image to select as target board

Target MCU updates to match board MCU

SDKa far selectod MU

Hame Yerwon

220

Location
5 50K 2. LPCopressoS4808

(i “Defumudt Locations /SDK 25 APCNprensedd

’ 3) Click next

Caned

[ et ]
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Follow along: Importing an SDK example

SOK Import

/4, The source from the SOX will be copied into the workspace. w &7
I you want to use linked files, plesse untip the SDK_1x_LPCXpressa54508' SOX,

.lmpon projects 2
Project name prefic IpCxpressoSStig i Project name suffic & ‘
19 Use default location [l

CAUsess\ 73BN\ Docunvert O MC U X peessnlDE_L1000_318 _rel_1\workapecehpcapresso 4008 _ |
Project Type Project Optioas
@ C Project =+ Project C Static Libran »» Statec Libwary [¥ Enable seminost jEI
Copy soucces 1
e wl e Mg ®BE
I
type o filter
Name Venica - |
«®mC Mu-nglu
1 E sdc
" E ctimer
T E dma
| & denic
18 ame
1S wenet . /(.
e pr— 4) Expand driver_examples and
L I N . -
B ¥ led cupe select gpio > led_output
1B 2 _ |
o« —— i ] »
/ 5) Finish
@ T T T

B workspace - Develop - Welcome page - MCUXpress:
Fle Edit Mavigate Seauh Project Run Free!"OS Window Help

irg v | > Q@i mmNe L 2|lSE (0SB R G

15 Project Explorer 37 7 Peripheralse 1! Registers L./ Symbol Viewer g’ == 0o
L 5 IpoxpressoS4608_driver_examples_gpio_led_output

\ A After unpacking / processing, project appears in

the project explorer window
6) Click to expand project content

_File [Edit ngate Search Pro;ect Run FreeRTOS Window Help
rsiv;-'-t.x‘ 'u'] ® - ‘ v o \} DI e ‘[ =

Project Explorer &3 ?b Peripherals+ 1{!i Registers &, Symbol Viewer

% 5 Ipcxpresso54608_driver_examples_gpio_led_output
b @ Includes
> (B CMSIS
s (23 board
b (2 drivers
b (2 source
b (3 startup
b (3 utilities
- [ doc
(= libs
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Follow along: Building SDK example

[ Project Explorer 52 2, Peripherals+ i Registers X Syn
29 lpcxprsso54608 dnvef _examples_gpio_led outputl

> @)l Includes
: S EMS:S 7) Click on the project
a ,.:::,R top level to make it active

() Quickstar... &3 (9= Global Va... (%)= Variables ©9g Breakpoi... Outlil

. MCUXpresso IDE (Pro Edition)
|_108 )

After selecting a project,
options to Build, Clean and
Debug become active

w Start here

. New project...

. Import SOK example(s)...

& Import project(s) from file system...
& Build 'Ipcxpresso54608_demo_apps_touch_cursor’ [Debug] _ 8) Click Build
/ Clean 'lpcxpresso54608_demo_apps_touch_cursor’ [Debug]

g Debug ‘IpcxpressoS54608_demo_apps_touch_cursor’ [Debug)

s

%) Edit 'Ipoxpresso54608_demo_apps_touch_cursor’ project settings

nstalled SOK Bconwk 2 [T Propertie ' Problen [ Memory «) Instruction Trace WO Trace
CDT Build Console [Ipcxpresso54608_driver_examples_gpio_led output]
Fanisneu Dusiudng:s .. /ouanwy CiuCk LSRN L.
arm-none-eabi-gcc -stdegnu®9 -DCR_INTEGER_PRINTF -DOEBUG -D_ USE_CMSIS -DCPU_LPCS46@8)512ET1¢
Finished building: ../board/pin_wx.c

Finished building: ../CMSIS/system LPC546088.c

Building target: lpcxpressoS54608_driver_examples gpio_led output.axf

Invoking: MCU Linker

arm-none-eabi-gcc -nostdlib -L"C:\Users\nxp7336@\Documents\MCUXpressoIDE_10.0.0_318_rc2_1\wor
Mesory region Used Size Region Size Xage Used

PROGRAM_FLASH: 16836 B 512 K8 3.21%
BOARD_FLASH: ° GB 16 M8 0.00%
SRAM @ 1 2 3 8496 B 16@ KB 5.19%
SRAMX: e a8 32 k8 0.00%
USB_RAM: e 68 s X8 e.0ex
BOARD_SDRAM: @ GB 16 M8 0.00%

Finished building target: lpcxpresso54608_driver_examples gpio_led output,axf

make --no-print-directory post-build

Performing post-build steps

arm-none-eabi-size "lpcxpresso54688_driver_exasples gpio_led output.axf™; ® arm-none-eabi-obj

text data bss dec hex filenaze
16832 - 8492 25328 627@ lpcxpresso54608_driver _examples gpio_led output.axf

15:41:34 Build Finished (took 25.810ms)

When Build starts, Console panel becomes active (bottom right
of IDE) and shows build progress
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LPCXpresso54608 Board Configuration LPC54608 target MCU

(Cortex-M4F)

Connect USB cable from PC to
“Link™ port (J8) to power main
board and debug probe

el

{

h N uuu] ¥~
L

-

Before connecting to USB,
ensure that “DFU Link” (JP5)
jumper is fitted so that
MCUXpresso IDE can soft-load
probe firmware

LPC-Link2 debug probe MCU
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Follow along: Start ession

Debug S

| - l
Cooenct 1o targes LOCEAONT LY
PR
Fle B MNevgee  Sewch Ran Franl
-, D SR 0-9 Availabiu sttocsed protes
e . Tewe Sevtwman® Tw  Bew. EC0wey [T,
e s Poybah- Bl Sy (RO R T AT Sangal T, Pk ooy

Note: use Quickstart
Debug, not this icon

o <5 ogreassHO08_dema_apps 10uch_ouner

& srerce

w Start here oo

- New project...
. Import SDK example(s)...

The IDE should
identify and boot the
Link2 with CMSIS-
DAP firmware image

& Import project(s) from file system...
Q Build 'lpcxpresso54608_driver_examples_gp#6_led_output’ [Debug]
J Clean 'Ipcxpresso54608_driver_exampfes_gpio_led_output’' [Debug]

W Debug 'Ipcxpresso54608_driver_examples_gpio_led_output’ [Debug]

Select project in the Project
Explorer View, then click on
Debug in the Quickstart Panel

| Allow Access for Windows
Firewall warnings to Domain and Private networks
(will only appear first time)

B8 Probes discovered e — T — @m

Connect to target: LPC54608)512
1 probe found. Select the probe to use:

Available attached probes

Name

Serial number/ID  Type

Manu... IDE Debug Mode

(R TPC-LINKS CMSIS-DAP Vo1 "CSAVCQAR

LinkSen NXP Ser Non-Stop

These settings will be

remembered

Supported Probes (tick/untick to enable/disable)

™ MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

[¥] SEGGER J-Link probes

for next time you
debug this project

Probe search options

[#] Remember my selection (for this Launch configuration)

@ [

ok [ cancel |

Click OK

A —

Note: By default, selecting “Debug” will trigger a build before
the debug session is launched, so it is not necessary to run

a “build” first
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Follow along: Develop Perspective — Debugging

Registers
and
Peripherals
views

Variables,
Global
Variables
and
Breakpoints
views

Run
Controls

U1 Regrstery
Hame Vabue
« M LPCE08ISL2 (conens
o 000000000
Wa ;2000020C
Ny 2 0000402
U 0s00000000
) 000000174
U 000000000
Ly Y HHon>
. "

o R O

| Varisble Type

¢ (B watFreglookup const went ¢ [37]
U witFreghockupld] const wens t
él-)- wiltFreqlockupll] const uess t
b witFreglockupll] const uentf t
O watFreglockupld] const wesl t
o wiitFreglookupfd] const et t
i wiltFreglockup{5] const i t
O wiltFreqlockuplS] const wedS_t
0 wiltFreqlockup{7] const el t
. -
Name : wdtFreqlockup[®]
Detalls: 0 "\0'
Default: 0 "\@'
Decimal:@
Mex : Bl

) Quick... )+ Globa.. > Vara., 9 Break.. = Outlice "' )

Quick Accens L'_ E

= 4 Det %/ T=n
ol + Bl poprenaSIE08_drver_examples_gpio_led_output Debug [C/C+« (NXP Semniconducton) MCU Apphcation] - Deb u g
Dised a 4 3 IpcepressoS46028_driver_examples_gpio_led_output.ad [LPCSIE0BS12 (conen-nd)] .
; 480 @ @ Theead #1 1 (Stepped) (Suspended : Step) - -
POprasss B maind) 2t gpio_led output o84 0656 VI eW
wl Arm-nome-eabi-gdb (7.12.0 20161 204)
£ gpho led output.c 1T =0
uintid t port_state = O} -
* Define the fnit structure for the cutput LED pin®
« B grio_pin_config t led_cenfig = {

' s hGPIO Digitoloutput, 0,

. Editor
) 5 e
s Mk iy Sk, guhigcoiate it view

atta b z cloc {debug con

CLOCK_AttachClik(BOARD DEBUG (MRT_CLK_ATTACM); o

' i3 CLOCK_EnmableClock(BCLOCK Spiod); |
g CLOCK_EnableClock(RCLOCK Gopiol);
CLOCK_EnableClock(RCLOCK GpieZ);
CLOCK_EmableClock(MCLOCK Gpiad);

Console,

E = r -
_—_- T Memory
LockF ;
0 <g_pinVed m":::&:::::::; ) £
0w : and
126 4200 o BELAR i bR hsElaal. ¥ 3
2100 ‘ b
» Trace
1B5 Y " . o Cannde (L . ! 0 Memory &1 4 = e & Tl o0 = .
100" ot ey {'T { [‘1 Lo VIeWS
o Monaors & X B 0:00 <Trodtioral> [} gk New Rendesings..
oW - e 0 BB00E0000 20023000 00000155 BROGRIFD FOUGEIS] BOGBA205 ... K. F..... . uees -
’ Sx00060014  00OS0209 10000210 DFFDTAS2 I0O0HIN0 B0GR0080  ..... . BtyR
. SxD0000025  D00OI00S HOCO0I11 BEBOEZ1S OOOVEO00 BOGSN21S  ..... .. ......
£ 0x00000G3C  00GAAILI0 NH000295 BODBOZAL POONNZA BRBA0L ... feu B tl,
000000050 DORDR269 10000201 PODRRCT HONNEITL Geedd20  ...A. B0l DLl
- Ex00060064  DOCOOIEL 10001110 BOOOBIFL 0NN F) GOGBOINT Bt Feu il eain
; 2x00000078 00Q0V309 P00037 1] BOBERI1Y GIR0EIIL BORBAIS  ....... ...l . )ees -

Leunching lpcrpressoSd...Debug: @8%) s D D NP LPCSUNEISL tpopis,. sutpud)
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Follow along: Develop Perspective — Debugging

Resume (F8)

- Image downloaded to flash
and execution started

- Default breakpoint set on
function main()
- Debug View displayed
automatically

- Shows / controls current
scope and target (multicore)

- Run controls are on main
toolbar

Terminate (Ctrl-F2) Multi-processor

Resume/Pause/etc.
Suspend Step
Into (F5)
Step
Step Return (F7)

Over (F‘V
) / :

jisters 23 = B %% Debug 3
RIS © 4 - lpcxpresso54608_driver_exa
Description 4 4 % Ipcxpresso54608_driver,
4 ® Thread #1 1 (Stoppt
Ipcxpresso546( - . :
30 = main() at gpio_|
% w arm-none-eabi-qdb (7.
)2 - Lc] gpio_led_ot
X0 31 uint32_t port_st
74 32
0 /* Define the in
9 - 9 gpio _pin_config
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Follow along: Develop Perspective — Debugging

- Click Resume (or press F8 key on keyboard) to execute the application.

- Press and hold switch SW2(1SP2) to make LED3 blink. Press and hold switch
SWA4(ISP0) to make LED1 blink.

- Click Suspend to pause execution.
- Click Restart to go back to beginning of application.
- Click Terminate to quit the debug session
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emWin Overview
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emWin Introduction

- Reliable embedded GUI middleware from SEGGER

- Hardware friendly

- Needs few kB of flash and <= 1kB of RAM to run core functions
- Supports all kinds of LCD panels/modules

- Comprehensive GUI features

emWin

Optional components
Window Manager Memary Devices Antialiasing VNC Server

Font Corwerter Multirper/-daaplay

emWin basic

Graphic Library Basic Forts Simutation Library emWinView

Baamap Corverter Color Conversion TouchvMouse Support

Display driver
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emWIN Licensing

No royalty or license fee with any current NXP ARM Cortex MO, M3 or M4 MCU
Source code available under license agreement from SEGGER
Multiple deployed customer applications using emWin on LPC.:

ATM machines, paper money counter, Industrial touch panel, Elevator control,
Security panel

* Free to download and use from nxp.com, includes library and
set of Windows utilities, GUI builder, bitmap & font converters

» Can be used with MCUXpresso, Keil, IAR and other ARM
development tools

« Examples provided with LPCOpen (pre 2017 devices) and
SDK (LPC54000 series)

emWIN is included in MCUXpresso SDK packages (for
LPC546xXx)
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What NXP customers used emW.In for...

- Paper money counter (LPC4300 + 3.1" LCD)

- ATM (LPC1800 + 14”7, 1024x768 LCD)

- Industrial touch panel (LPC1788 + 10.17, 640x480 LCD)
- Washing machine (LPC3000)

- Elevator control with LCD (LPC1788)

- High accuracy scales with LCD (LPC1788)

- Security Panel (LPC2132)
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Tools overview e

Croloes

- Bitmap converter - Can be used for converting
Images into C-files or streamed bitmaps.

- emWinView - Can be used to view the content of the
display while stepping through the a simulation.

.............

- Bin2C - Can be used for converting any kind of file
Into byte arrays which then can be used within a C
file.

SEumEmE

CUIBuildar

- U2C - Can be used to convert UTF8-text into C-code ErErT e L

- Font converter - Can be used for converting any
font installed on the host system into emWin
compatible formats.

- GUIBuilder - Can be used to generate dialog based
applications without writing any line of code.
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GUI-Builder

The GUI-Builder is a tool for creating dialogs without
using C

Basic usage of the GUI-Builder:

Check project path in GUIBuilder.ini
Thils file can be found in the application folder of the
tool.

Start GUI-Builder

Start with FRAMEWIN or WINDOW widget
Only these widgets are able to serve as parent
windows for a dialog here.

Place widgets within the parent window

The widgets can be placed and sized by moving them
with the mouse and/or by editing the properties in the
property window.

Configure the widgets _ _
The context menu shows the available options.

Save dialog _ _

Each dialog is saved in a separate file. The filenames
are generated automatically by the name of the parent
window.

The filenames are automatically generated by the name
of the parent window: <WindowName>Dlg.c

L
Beow i
-

Menu bar Object tree Widget selection bar

= jg.i‘_.\ - GUIBuilder

Ok

Cancel

‘ A0 ‘uj} £ k T [ 3
Widget properties Editor
Capabilities:

* Files can be opened by drag and drop
*  Multiple dialogs allowed simultaneously
+ Each dialog is saved in a separate file

« Filenames are generated automatically
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Skinning

- Skinning is used to change the appearance of one
or multiple widgets. Currently emWin supports 2
skins:

- Default skin
Old classic style. Look can be changed by using the API
functions described in the 'Widget' chapter of the
documentation.

- FLEX_SKIN
Flexible skin, can easily be modified by a custom
skinning routine.

The default skin for each kind of widget can be set
by:

<WIDGET>_ SetDefaultSkin()

The skin of each single wigdet can be set by:
<WIDGET>_SetSkin()

- Properties of FLEX_ SKIN can be fetched / set by:

<WIDGET>_ GetSkinFlexProps()

#include "DIALOG.h"

static int _ScrollbarSkinCust(const WIDGET_ITEM_DRAW_INFO * pDrawItemInfo) {

switch (pDrawItemInfo->Cmd) {
case WIDGET_ITEM_CREATE:
WM_SetHasTrans (pDrawItemInfo->hWin);
break;
case WIDGET_ITEM_DRAW_BUTTON_ L:
case WIDGET_ITEM_DRAW_BUTTON_R:
GUI_SetColor(GUI_GRAY);
GUI_FillRoundedRect(pDrawItemInfo->x0, pDrawItemInfo->yo,
pDrawItemInfo->x1, pDrawItemInfo->yl, 4);
GUI_SetColor (GUI_WHITE);
GUI_DrawRoundedRect(pDrawItemInfo->x0, pDrawItemInfo->y@,
pDrawItemInfo->x1, pDrawItemInfo->yl, 4);
GUI_SetColor (GUI_BLACK);
GUI_FillCircle((pDrawItemInfo->x1 + pDrawItemInfo->x@) / 2,
(pDrawItemInfo->yl + pDrawItemInfo->y@) / 2, 4);
break;
case WIDGET_ITEM_DRAW_SHAFT_L:
case WIDGET_ITEM_DRAW_SHAFT_R:

GUI_SetColor(GUI_WHITE);

GUI_DrawLine(pDrawItemInfo->x0, pDrawItemInfo->y@, pDrawItemInfo->x1,

GUI_DrawLine(pDrawItemInfo->x0, pDrawItemInfo->yl, pDrawItemInfo->x1,

break;
default:

return SCROLLBAR_DrawSkinFlex(pDrawItemInfo);
}

return 0;

}
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Hands-on — Session #2

Hands-on session with following
objectives:

- Build and run an emWin example from the
LPC54608 MCUXpresso SDK

- Modify the example to add a logo
- Create a simple GUI using GUIBuilder tools
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Follow Along: Running out of Box example

- Open a new workspace.

- From the Quickstart Panel -> O
Import the SDK example(s) , e
select the touch_and_draw T e e
examples under
emwin_examples section.

- Upon clicking finish, the example
IS Imported into the current

v

workspace.

- Expand the project to view the
project structure. Expand every
folder to view the files within the
folder.

« 7 Ipcxpresso54608_emwin_examples_touch_and_draw
» Includes
£ CMSIS
4 = board

& board.c

W board.h

g clock_config.c
N clock_config.h
& pin_mux.c

N pin_muxh

2 drivers
4 £ emwin
4 (= emWin_Config

v GUIConfh
i LCDConfh

= emWin_header

@ emWin_library
ChangelogKSDK.txt
readme.txt

4 |2 source

¢ touch_and_draw.c

4 (@ startup

& startup_LPC54608.c

4 (2 touchpanel

o fs]_ft5406.c
) fsl_ft5406.,h

4 (= utilities

o fsl_debug_console.c
N fsl_debug_console.h

4 (> doc

readme.txt

4 (> libs

an libfsl_power_lib.a
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emWin Configuration

. . . . . : 2 board
- There are two compile time configuration files . 65 drivers
. . . 4 & emwin
- GUIConf.h - Configuration of available GUI features 4| emWin Config
-LCDConf.h - Display driver configuration (obsolete) I i

= emWin_header
» = emWin_library
= ChangelogKSDK.txt
El readme.txt
: [ source
- (& startup
- 2 touchpanel
- & utilities
» = doc
» = libs
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Follow Along: Build and Run example

- In the Quickstart Panel click Debug.

- This builds the project and enters debug mode.

- Click resume 1= or press F8 to execute the example.

- Interact with the example using touch screen, buttons etc.
- Touch and drag on the LCD screen to draw.
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Change Background Bitmap Image

- Use the emWiIn tools to convert a bitmap to C source and compiled into the project

- In the touch_and_draw example, the background is white. We will replace the
background with an image.

-
| 2 |
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Follow Along: Choose a Bitmap Image

- To create a new bitmap to use as the display background, you have two choices:

- Use the available NXP logo provided in the project folder. All instructions are written for
this case, so this is the easiest path.

- Navigate the folder emWin_Tools in the package. This folder contains various
emWin tools.

EP Bin2C.exe

@ BmpCvt.exe
ﬂ emVNC.exe

¥ emWinView.exe
GUIBuilder.exe

3| GUIBuilder.ini
JPEG2Movie.exe

™ nxplogo_small.bmp

U2C.exe
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Follow Along: Choose a Bitmap Image

File Edit View Image Options Help

- Open the Bitmap Conversion application S e
“BmpCvtNXP.exe”. 5] m-‘\ a

. Locate the file “nxplogo_small.bmp”. A/\l
Drag and drop it onto the app
“‘BmpCvt.exe”.

. Save the file in C format. Click File -> e 7
Save As, change the type to “C bitmap P A
file” and click Save. e
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Follow Along: Choose a Bitmap Image

- The “Format Specification” dialog opens. Scroll to the bottom of the list and select

“True color 24 bpp”. Then select OK. A ‘C’ source file is created in the Tools
folder.

- Copy and paste the “nxplogo_small.c” file into the workspace source folder of the
project (choose “Copy” when prompted to copy or link to the file)

2 drivers

4 (2 emwin
& emWin_Config
= emWin_header
= emWin_library
1=} ChangelLogKSDK.txt
(=] readme.txt

4 |} source

te] nxplogo_small.c

Le] touch_and_draw.c
4 2 startup

le] startup_LPC54608.c
4 (2 touchpanel

- £al ST ANC
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Follow Along: emWin API to Draw Bitmap image

The API GUI DrawBitmap () is used to draw the bitmap image. Refer to the emWin user Guide for details of the
API call. This API takes 3 parameters: pointer to the bitmap to display, x position and y position.

Copy the following lines of code and paste it inside “touch_and_draw.c” as specified:

- Declare the following line with global scope.
extern const GUI BITMAP bmnxplogo small;

- Paste the following as first statement inside for(;;) loop.
GUI DrawBitmap (&bmnxplogo small, 130, 0);

Example:
for (;7)
{
GUI DrawBitmap (&bmnxplogo small, 130, 0);

Build and Debug the application. Observe the updated bitmap displayed in the background of the frame.
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Creating New application using emWin GUIBuilder

- The GUIBuilder application is a tool for creating dialogs without any knowledge of
the C programming language.

- Instead of writing source code the widgets can be placed and sized by drag and
drop

- Additional properties can be added per context menu. Fine tuning can be done by editing
the properties of the widgets.

- The dialogs can be saved as C files which can be enhanced by adding user
defined code.

- These C files with the embedded user code can be loaded and modified by the
GUIBuilder

-
| 2 |
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Follow Along: Creation of GUI

- Note : The GUIBuilder.ini file contains the path

where the GUIBuilder.exe tool is located. All saved |se yew e

files pertaining to GUIBuilder application will be in
this path. Please modify the path if required.
Default path in the package is: "C\FTF 2017
Training\emWin_Tools\"

- The ini file is created the first time GUIBuilder.exe is run

- Open the GUIBuilder “GUIBuilder.exe “application
inside the emWin_Tools folder. Examine the
capabilities of the tool.

- Create a new window by clicking on the FrameWin
dialog icon. The default size of the window is 320 x
240. This can be changed by editing the properties
of the window. Edit the properties and set xSize to
480 and ySize to 272.

Property

I Value

Name
xPos

yPos

xSize
ySize

Extra bytes

Frame...
0

0

480
272

0




Follow Along: Creation of GUI

- Create a Button by clicking the Button icon.
Drag the created Button to the center of the
frame.

- Click the Button and change the Button
properties such as Name, xPos, yPos, xSize
and ySize to match the screenshot below.

Name = “On/off” , xPos = 170, yPos = 100, xSize = 110, ySize = 40.

- Save the GUI by clicking File -> Save. This
creates the file FramewinDLG.c in the
emWin_Tools folder ( refer to path specified in
the GUIBuilder.ini file).

=y Framewin
On/Off

...................

Property

I Value |

Name
xPos

yPos
xSize
ySize

Extra bytes

On/Off
170
100
110

40
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Follow Along: Add FramewinDLG.c file to project workspace

- To do this either drag and drop the FramewinDLG.c file into the source folder of the
project in workspace or copy the FramewinDLG.c and paste it in the source folder

of the workspace.

4 ' Ipcxpresso54608_emwin_examples_touch_and_draw
i Binaries
n Includes
& CMSIS
& board
2 drivers
2 emwin

4 (2 source
kgl FramewinDLG.c
.¢| nxplogo_small.c
\¢| touch_and_draw.c

4 (2 startup
kel startup_LPC54608.c
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Follow Along: Add code to create window frames

Create a new copy of the existing “touch_and_draw.c”
file in source folder. To do this copy/paste the file in the R R

project workspace in source folder and name the new o i
file as “touchbutton.c”. 5 cusis
A board
- Exclude the “touch_and_draw.c” file from build. o
- Delete or Comment all lines after GUI_Init() function. e
- Copyl/paste the following lines after GUI_Init(). B i
touch L
4 (5 startup Open
CreateFramewin () ; @ e e
3 ol 15 Corg?ry' Cfrlfc
WM_EX@ C ( ) ’ 5 Quickstart Pane % Delete Delete
. Source »
Wh * l < ( 1 ) U Xpe :ei:er;e... F2
{ v Start here 4 Import...
Ne : Ly Export.
WM_EX@C ( ) ; ::,w Refresh FS
} ® Import proje Index
K| 8y Resource Configurations ’ Exclude from Build... ‘
A Build Selected File(s) A .

- Build and Debug the application. When the application
IS executed, the GUI developed using GUIBuilder
appears on the LCD.
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Follow Along : Add code to Control an LED

. Edit the file “touchbutton.c” to initialize LED. Paste the = “™

Createfromewin();
WM_Exec();

following lines before GUI_Init(). This will initialize e

GUI_PID STATE pid_state;

LED3 On the board . ?5 (kStatus_Success 1= FT5406_GetSingleTouch(&touch_handle, &touch_event, ScursorPosX, &cursorPosY))
LED3 INIT(O0);

PRINTF("error reading touch controller\r\n");
}
else if (touch_event != kTouch_Reserved)
{
pid_state.x cursorPosy;
pid_state.y = cursorPosX;
pid_stote.Pressed = ((touch_event == kTouch Down) || (touch_event «= kTouch Contact));

- Copy paste the following lines after GUI_Init(). L N

: W _Exec();
CreateFramewin () ;
WM Exec(); 8 )
while (1)
{
GUI PID STATE pid state;
if (kStatus Success != FT5406 GetSingleTouch(&touch handle, &touch event, &cursorPosX, &cursorPosY))
{
PRINTF ("error reading touch controller\r\n");
}
else if (touch event != kTouch Reserved)
{
pid state.x = cursorPosY;
pid state.y = cursorPosX;
pid state.Pressed = ((touch event == kTouch Down) || (touch event == kTouch Contact));

pid state.Layer = 0;
GUI TOUCH StoreStateEx (&pid state);

WM Exec();
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Follow Along : Add code to Control an LED

Edit the “FramewinDLG.c” file and add the
following code to the USER section,

around line 22: S

#include “board.h”

In the file “FramewinDLG.c”, add the
following code to the cbDlang() function
for the selected notifications “CLICKED”

and “RELEASED".

CLICKED : LED3 ON () ;
RELEASED: LED3 OFF (N

Build and Debug the application.

Run the application. When the button is
pressed on the LCD, LED3 switches ON.

When the button is released, LED3
switches OFF.

3 * SEGGER Microcontroller GmbH & Co. KG
20

21 // USER START (Optionally insert additional includes)

22 #include "board.h"

Pt SER—END
24
25 #include "DIALOG.h"

26

Y7 Jf 83K SR R R SRR RN KRR 35 RO IR SICROIC KRR I SRR HII0OROK 3R IR R SHOR R IO IICR 3R R R HOR RO OK R
L /

| 75 static void _cbDialog(WM MESSAGE * pMsg) {

int NCode;

int Id;

// USER START (Optionally insert additional variables)
// USER END

switch (pMsg->Msgld) {
case WM_NOTIFY_PARENT:
1d = WM_GetId(pMsg->hWinSrc);
NCode = pMsg->Data.v;
switch(Id) {
case ID BUTTON_@: // Notifications sent by 'On/Off’
switch(NCode) {
case WM_NOTIFICATION_CLICKED:

LED3_ON();

// USER ERND
break;

case WN NOTIFICATION_RELEASED:

LED3 OFF()

break
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Follow Along : Add Skinning to change GUI appearance

- Skinning allows customization of the GUI across various widgets, automatically applying the same look across all items within a frame
- Add the following lines in touchbutton.c just before calling CreateFramewin () ;

BUTTON SKINFLEX PROPS Props;

FRAMEWIN_SetDefaultSkin (FRAMEWIN_SKIN_FLEX) ; = GUIP;n;:(;‘J” |
BUTTON SetDefaultSkin (BUTTON SKIN FLEX) ; 386

— — — 387 BUTTON_SKINFLEX_PROPS Props;
WIDGET SetDefaultEffect (&WIDGET Effect 3D); 38

FRAMEWIN SetDefaultSkin(FRAMEWIN SKIN FLEX);
FRAMEWIN SetDefaultFont (GUI_FONT 32 ASCITI);

390 BUTTON_SetDefaultSkin(BUTTON_SKIN_FLEX);

. . 391 WIDGET_SetDefaultEffect(&WIDGET_Effect_3D);
FRAMEWIN SetDefaultTextAlign (GUI TA HCENTER); 392 FRAMEWIN SetDefaultFont(GUI_FONT 32 ASCII);
393 FRAMEWIN_SetDefaultTextAlign(GUI_TA_HCENTER);
BUTTON GetSkinFlexProps (&Props, BUTTON SKINFLEX PI FOCUSSED) ; 395 BUTTON_GetSkinFlexProps(&Props, BUTTON_SKINFLEX_PI_FOCUSSED);
396 Props.aColorframe[@] = @x@07FB13(C;
Props.aColorFrame[0] = 0x007FB13C; 397 Props.aColorFrame[1] = @x@@8FfF8F;
Props.aColorFrame[l] = 0x008FfF8F; 398 Props.Radius = 6;

BUTTON_SetSkinFlexProps (& rops, BUTTON_SKINFLEX_PI_FOCUSSED);
Props.Radius = 6; 400
) 401 CreateFramewin() ;|
BUTTON SetSkinFlexProps (&Props, BUTTON SKINFLEX PI FOCUSSED); ann LM S fN.
- Add this include to the top of touchbutton.c:

#include “DIALOG.h”
- Build and Debug the application. Test the code by executing the application.
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Other emWIN Features




emWin Library Functions

The following features are covered by the base package:
- Drawing and images
- Software alpha blending
- Image file support for BMP, GIF, PNG and JPEG
- Drawing of images from non addressable media (using GetData call back)
- Sprites and cursors (also animated)
- Lines, polygons, rectangles, arcs and circles
- Fonts and text
- Standard font package (ASCII and 1ISO 8859-1)
- LTR (Left to Right), RTL (right to Left) and bidirectional text support
- Support for all non anti-aliased font formats
- Drawing of values (dec, bin, hex and float)
- Virtual screens (physical screen smaller than virtual screen)
- Touch screen support
- Multitasking support
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Widget library

Widget = Window + Gadget
Currently the following widgets are supported:

- Button, Checkbox, Dropdown, Edit, Framewin,
Graph, Header, Iconview, Image, Listbox, Listview,
Listwheel, Menu, Multiedit, Progbar, Radio,
Scrollbar, Slider, Text, Treeview

Creating a widget can be done with one line of code.
There are basically 2 ways of creating a widget:

- Direct creation
For each widget there exist creation functions:

- <WIDGET> CreateEx() : Creation without user data.
- <WIDGET> CreateUser() : Creation with user data.

- Indirect creation
Indirect means using a dialog box creation function
and a GUI WIDGET_ CREATE_INFO
structure which contains a pointer to the indirect
creation routine:

- <WIDGET> CreatelIndirect() : Creation by dialog
box creation function.

Check Item# | EAM + | amount [

Direct creation

void MainTask(void) {
WM_HWIN hWin;

GUI_Init();
hWin = FRAMEWIN_CreateEx(10, 10, 100, 50, WM_HBKWIN, WM_CF_SHOW, ©, 0, "Window", NULL);
while (1) {

GUI_Delay(100);

}

Indirect creation

#include "DIALOG.h"
static const GUI_WIDGET_CREATE_INFO _aDialogCreate[] = {
{ FRAMEWIN_CreateIndirect, "Window", @, 10, 10, 100, 50 }

};

void MainTask(void) {
WM_HWIN hWin;

GUI_Init();
hWin = GUI_CreateDialogBox(_aDialogCreate, GUI_COUNTOF(_aDialogCreate), NULL, WM_HBKWIN, O, 0);
while (1) {

GUI_Delay(100);

}

(

Buktkbon J

Iker O

4 3
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Common dialogs

Common dialogs available:
- Message boxes

- Color selection

- Exploring a file system

MESSAGEBOX

- Only one line of code required for a message box.
CHOOSEFILE

- Embedded file system explorer.

- Simple callback mechanism used to get file data from application.
- Ready to use sample for emFile available

CHOOSECOLOR

- Selection from an application defined array of colors.
CALENDAR

- Selection of a date of the gregorian calendar.

Mame

- |Size Twpe Akkrib

Applicakion
CleanUp
—onfig

=L
Simulation

This text is shown
in a message box

r Sirnulaktion
Simulation
Sirnulaktion
Sirnulation. woxproj
Sysbem

596 B bat

81.042 B .dsp
543 B .dsw
891 B .sln
563,129 B . vCxproj
103,953 B .filkers

| i\ Templ09) Start)

I~ (&)

ARERONARRARCACNE
RERCRERARCACEN
CRCACARCACAEAC
ARCRCRRCACACAR
RCRCERCACACAREN
CRCRCARCACRCHNEN

A

RRCRCNNIONONCN 8

ROCNENNROERER
RCRRENIO NN
RCRRCNRRONONCN
ONCHENNANENENCE
RRCHONRARONENEN

o
b

] UNCRCHACACACACER

SN 10 0] { (of {of fof [ |
T CHOSNENRRORRNRNN

Cancel

SR I 1L

4 2013

January 3
53 Su Mo Tu We Th

Fr

1 2 3
5 6 F &
12 13 14 15
19 20 21 22
26 ZF 2§ 29

16 17
23 24
30 31

o [1o N

4

15
25
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Memory devices

- How do they work?

- Drawing operations can be passed to a memory device instead
to the display to prevent display from flickering. A memory
device is a hardware independent destination device for
drawing operations.

What can they be used for?

- Preventing flickering

- Container for decompressed images
- Scaling and rotating

- Fading operations

- Window animations

- Transparency effects

- What does 'transparency' mean here?

- Memory devices with transparency 'know' the pixels which
have been accessed. One additional bit is required per pixel for
ator_ing this information. Supported by 1, 8 and 16bpp memory

evices.

Do memory devices support alpha blending?

- Yes, 32bpp memory devices support alpha blending, but not
‘transparency’

#include "GUI.h"
void MainTask(void) {
GUI_MEMDEV_Handle hMem;

GUI_RECT Rect = { 10, 10, 109, 109 };

GUI_Init();

hMem = GUI_MEMDEV_Create(Rect.x@, Rect.y@, Rect.x1 - Rect.x® + 1, Rect.yl -

1);
GUI_DrawGradientH(Rect.x@, Rect.y®, Rect.x1, Rect.yl, GUI_RED, GUI_BLUE);
GUI_MEMDEV_Select(hMem);
GUI_DrawRectEx(&Rect);
GUI_SetTextMode(GUI_TM_TRANS);
GUI_DispStringInRect("This shows\n"
"how transparency\n"
"can be used with\n"
"memory devices"
, &Rect
, GUI_TA HCENTER | GUI_TA VCENTER);
GUI_MEMDEV_Select(9);
GUI_MEMDEV_Write(hMem);
while (1) {
GUI_Delay(1090);
} Without transparency With transparency

}

Rect.yo +



Antialiasing

- Antialiasing smoothes curves and diagonal lines =~ *nelude "6t
by "blending" the background color with that of the  static eur_poiNt _apPoint([] = {
f (j { '5: -5 }: { 0: -50 }: { 5: -5 }) { 50) % })
oreground. { s, { o 50}, { -5, 51,

5}, { -50, e},
}s
- emWin supports antialiased drawing of V°§31M;‘§g{§§'f<"°id> {
_ Text GUI_SetBkColor (GUI_WHITE);
. . . GUI_SetColor(GUI_BLACK);
Font converter is required for creating AA fonts. GUI_Clear();
ArCS GUI_SetPenSize(2);
- GUI_AA DrawLine(10, 10, 100, 50);
GUI_AA_DrawArc(10e, 50, 40, 40, 270, 450);
GUI_AA—Dr‘aWAr‘C () GUI_AA_FillCircle(50, 100, 30);
_ Circles GUI_AA_DrawPolyOutline(_aPoint, GUI_COUNTOF(_aPoint), 4, 200, 100);
. . GUI_AA FillPol (_aPoint, GUI_COUNTOF(_aPoint), 100, 170);
GUI_AA FillCircle() while (1) oo o
_ Lines , GUI_Delay(100);
GUI_AA DrawlLine() }

- Polygons

GUI AA DrawPolyOutline() “““xxx{:>

GUI_AA FillPolygon()

Note:Performance of antialiased drawing operations degrades .
significantly in comparison to non antialiased drawing operations.
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Window Manager

Management system for a hierarchic window
structure

Each layer has its own desktop window. Each desktop
window can have its own hierarchical tree of child
windows.

Callback mechanism based system

Communication is based on an event driven callback
mechanism. All drawing operations should be done within
the WM_PAINT event.

Foundation of widget library

All widgets are based on the functions of the WM.

Basic capabilities:

Automatic clipping

Automatic use of multiple buffers
Automatic use of memory devices
Automatic use of display driver cache
Motion support

#include "WM.h"

void _cbWin(WM_MESSAGE * pMsg) {
int xSize, ySize;

switch (pMsg->MsgId) {

case WM_PAINT:
xSize = WM_GetWindowSizeX(pMsg->hWin);
ySize = WM_GetWindowSizeY(pMsg->hWin);
GUI_Clear();
GUI_DrawRect(@, @, xSize - 1, ySize - 1);
GUI_DispStringHCenterAt("Window", xSize / 2, 10);
break;

default:
WM_DefaultProc(pMsg);

}

}

void _cbBk(WM_MESSAGE * pMsg) {
switch (pMsg->MsgId) {
case WM_PAINT:
GUI_DrawGradientV(®, ©, 479, 271, GUI_BLUE, GUI_MAGENTA);
break;
default:
WM_DefaultProc(pMsg);
break;
}
}

void MainTask(void) {
WM_HWIN hWin;

GUI_Init();
WM_SetCallback (WM_HBKWIN, _cbBk);
hWin = WM_CreateWindowAsChild(10, 10, 100, 100, WM_HBKWIN, WM_CF_SHOW, _cbWin,
0);
while (1) {
GUI_Delay(100);
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Design Considerations




Choosing a LCD : Resolution and Color Depth

- Resolution is not measured In HVGA WVGA | [WSVGA HD 720
. | \

Inches! .

- LCD resolution is quoted as Resoutions
width x height with units in oo NXP graphic
pixels. \ controller

VGA
-QVGA 320 X 240 oAxasl
- VGA 640 x 480 BA0AR0
- SVGA 800 X 600 XGA
1024x768
- Landscape or portrait orientation xGar

- Color depth or bits per pixel
(bpp) |

D15 D14 D13 D12 D11 D10 D9 D8 D7 D6 D5 D4 D3 D2 D1 DO

/ VA S

|
RGB555 + | color pattern as organized in memory

M. . Pad




What is a Frame Buffer?

- Contiguous memory buffer containing a complete frame of data
- Consists of color values for every pixel
- Color values are commonly represented as
-1 bit (1 bpp): Monochrome
-2 bit (2 bpp): Palette based (4 colors)
-4 bit (4 bpp): Palette (16 colors, controller has a palette look-up table)
-8 bit (8 bpp): Palette (256 colors, controller has a palette look-up table)
- 16 bit (16 bpp): High color format (5:5:5 - 32,768 colors; 5:6:5 - 65,536 colors)
- 24 bit (24 bpp): True color format (16,777,216 colors)
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Resolution x Color Depth = Memory Size

- Resolution x Color Depth = Total bits needed (divide by 8 for bytes)
- Framebuffer = Memory buffer containing complete frame (bitmap) of data

XGA 1024x768 98,304 196,608 393,216 786,432 1,572,864 2,359,296
WVGA 800x480 48,000 96,000 192,000 384,000 768,000 1,152,000

VGA 640x480 38,400 76,800 153,600 307,200 614,400 921,600

WQVGA 480x272 16,320 32,640 65,280 130,560 | 261,120 391,680

QVGA 320x240 9,600 19,200 38,400 76,800 153,600 230,400

CGA 320x200 8,000 16,000 32,000 64,000 128,000 192,000

Example: (480 x 272) x 16bpp = 2,088,960 bits
To convert to bytes : 2088960 + 8 = 261,120 bytes

PUBLIC | 67



Palette Based Frame Buffer

- The frame buffer will contain an index value for each pixel
- Palette RAM is pre-filled with 16-bit color value for each index

Framebuffer Palette Image

wn o non
O = N ™M

112(3|2]|1
2(3]2]1]0
3{2[(1]0]0

Ojo0f1]2]|3
Oj1(2|3]|2

- NXP microcontrollers have 256 entries to support
-1, 2, 4, or 8 bpp palletized color displays for color STN and TFT
-1, 2, or 4 bits-per-pixel (bpp) palletized displays for mono STN
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LCD TFT Display Pixel Layout

Pixel 0 (16 bits), Pixel 319,
line O line 0

320x240 TFT display /

RGB RGB RGB

RGB RGB RGB
Pixel 1, line 239

RGB RGB RGB

With a 18-bit TFT display, a clock of data will drive 1

pixel. It will take 320 clocks to drive all the data for a
R5...R0O G5...G0 B5...B0 320 pixel line.
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Driving a clocked LCD bus

Host MCU

VSYNC/FP
HSYNC/LP
Pixel clock
Data lines
PWM Constant Backlight
current

source
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Refresh Rate

Refresh_Rate(Hz) =

pixel_clock_rate

[(vertical_resolution + vertical_front_porch + vertical_back_porch) x (pixel_clocks_per_data_line + horizontal_front_porch + horizontal_back_porch)]

Example for a 320 x 240 LCD display:
- 6.5MHz pixel clock

vertical resolution=240 lines,

vertical front porch=5 lines,

vertical back porch=1 line,

pixel clocks per data line = 320 pixels,
horizontal front porch=20 clocks,
horizontal back porch=10 clocks

6500000

Refresh_Rate = [(2404+5+1)%(3204+20+10)] =755Hz
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LCD Controller Signals

- The largest configuration for the LCD controller uses 31 pins. There are many
variants using as few as 10 pins for a monochrome STN panel.

Pin name Type |[Function

LCD_PWR output [LCD panel power enable.

LCD_DCLK output [LCD panel clock.

LCD_AC output [STN AC bias drive or TFT data enable output.

LCD _FP output |Frame pulse (STN). Vertical synchronization pulse (TFT)

LCD_LE output |[Line end signal

LCD_LP output |Line synchronization pulse (STN). Horizontal synchronization pulse (TFT)

LCD_VD[23:0] |output [LCD panel data. Bits used depend on the panel configuration.

LCD_CLKIN input | Optional clock input. Each level on this pin must be at least 1 PCLK in duration in order to be
sampled. The maximum frequency must therefore be less than PCLK/2.
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LCD TFT Signals

Pin name 12-bit, 4:4:4 16-bit, 5:6:5 16-bit, 1:5:5:5 | 24-bit (30 pins)
mode (18 pins) |mode (22 pins) mode (24 pins)

LCD_PWR Y Y }Y Y

LCD_DCLK Y Y Y Y

LCD_AC Y y ¥ )

LCD_FP Y Y ]Y ;g

LCD_LE Y Y Y Y

LCD.LP Y 13 Y ¥

LCD_VD[1:0] - - - RED[1:0]

LCD_VD[2] - - Intensity RED[2]

LCD_VD[3] - REDI0] REDI0] RED[3]

LCD_VD[7:4]  |RED[3:0] RED[4:1] 'RED[4:1] REDI[7:4]

LCD_VDI[9:8] - - - GREEN[1:0]

LCD_VD[10] - GREEN[0] Intensity GREEN[2]

LCD_VD[11] - GREEN[1] 'GREENI[0] GREEN[3]

LCD_VD[15:12] |GREENI3:0] GREENI5:2] 'GREEN[4:1] GREEN(7:4]

LCD_VD[17:16] |- - - BLUE[1:0]

LCD_VD[18] - - Intensity BLUE[2]

LCD_VD[19] - BLUEIO] 'BLUE[0] BLUE[3]

LCD_VD[23:20] |(BLUE[3:0] BLUE[4:1] w BLUE[4:1] BLUE[7:4]
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Driving the LCD — Various Timings

VSYNC starts the
frame

~
~

Horizontal front
porch timing

Vertical back
porch timing

A

N
\
\

HSYNC starts at |
the beginning of |~
each line N

e

-

14

L k founded by Philips

Vertical front
porch timing

Horizontal back
porch timing

320x240 display shown with
timing for VSYNC, HSYNC,
clock, and porch values
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Snapshot of incorrect LCD settings

- Picture is an example for Truly G240320LTSW panel, which wrongly sets vertical
back porch to 8 while the correct value is 4, leading to 4 visible blank lines by LCD

panel.

T v —— -

M

static const LCD_PFRRREM T truly g2403201taw =

{

30, /S/28, ## Horizontal back porch #/
14, A% Horizeontal front porch *#/
2, A% HEYNC pulse width #/
240, /% Pixels per line *#/
a, A% Vertical back porch #/
2, JEVertical front porch =/
2 A* VEVYNC pulse width #/
320 A% Lines per pansl *#/

Vertical Back Porch

tvse
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Example : 480 x 272 LCD TFT Display Timing Table

- Below is the timing table of LCD used in LPCXpresso54608 Development board.

Item Symbol Min. Typ. Max. Unit
DCLK Frequency Fclk 5 9 12 MHz
DCLK Period Telk 83 110 200 ns
Hsync | Period Time Th 490 531 605 DCLK
Display Period Thdisp 480 DCLK
Back Porch Thbp 8 43 DCLK By H BLANKING setting
Front Porch Thip 2 8 DCLK
Pulse Width Thw 1 DCLK
Vsync | Period Time Tv 275 288 335 H
Display Period Tvdisp 272 H
Back Porch Tvbp 2 12 H By V_BLANKING setting
Front Porch Tvip 1 - H
Pulse Width Tvw 1 10 H
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LCD Tearing

- Tearing:

- Result of LCD DMA unable to service the LCD FIFO in time

- Use the FIFO Underflow to monitor for this

- Workarounds

- Change AHB priority — next slide

- Slow down frame refresh rate, pixel clock if possible

- Use 32-bit wide external memories

- Increase the SDRAM clock speed, use faster SRAM

- Profile code and move frequently accessed code to internal SRAM

PUBLIC | 77



LPC54608 LCD AHB Priority

- AHB Matrix Priority Register (AHBMATPRIO - 0x4000 0010)
- The values used for the various priorities are 3 = highest, 0 = lowest

Bit Symbol Description Reset value
1.0 PRI_ICODE |[I-Code bus priority. Should typically be lower than PRI_DCODE for best operation. 0
3:2 PRI_DCODE |D-Code bus priority. 0
54 PRI_SYS System bus priority. 0
76 PRI_DMA DMA controller priority. 0
9:8 PRI_ETH Ethernet DMA priority. 0
11:10 |PRI_LCD LCD DMA priority. 0
13:12 [PRI_USBO USBO DMA priority. 0
15:14 |PRI_USB1 USB1 DMA priority. 0
17:16 |PRI_SDIO SDIO priority. 0
19:18 |PRI_MCAN1 |MCAN?1 priority. 0
21:20 |PRI_MCAN2 [MCANZ2 priority. 0
31:22 |- Reserved. Read value is undefined, only zero should be written. -
- To give priority to the LCD DMA use the value 0x0000 0C09
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Bus Bandwidth Calculator

Bus Bandwidth on Various LCD Resolutions and Color Depths at Various Refresh Rate
EMC Bus Clock (MHz):
Dynamic External Memory Configuration -
Bus Width:
Precharge Command Period, tRP:
RAS Latency (Active to Read/Write Delay), RAS (tRCD):
CAS Latency, CAS:
LCD parameters
Horizontal (Pixels):
Vertical (Pixels):
Horizontal back porch (pixel clocks)
Horizontal front porch (pixel clocks)
Vertical back porch (lines)
Vertical front porch (lines)
Pixel clock rate (MHz)
Color Depth (bpp):
Results
Refresh Rate (Hz):
Frame Buffer (KB):
LCD Data Rate (Mpixels/s):
LCD Data Rate (MWords/s):
LCD Data Rate (Mbursts/s):
Dynamic External Memory Burst -Burst (clocks):
Bus bandwidth required (%):

WWiw o

480

272

32

12

16

60.1
255

7.8

3.9

1.0
22
22.5%
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